
Why hello and welcome! 🌎 Official Website: cspersonalfinance.io →

Welcome! This tool is designed to make life easy for you, give you a holistic glimpse of your financial position and if you're into stats tell you where you're heading.

Everything is as automated as possible, data entry takes place once a month and is minimal. Please note to use this Sheet you must have a Google Account.
Please read the disclaimer before continuing and please share the link to this sheet with anyone you think might use it!

While the Sheet may appear complicated, required input is minimal and the rest is automated. Only a few yellow cells require your input!

🌎 Getting Started Guide →

Disclaimer

The information & guidance on this sheet is for general information only.

It should not be taken as constituting professional advice from the Sheet owner. I am NOT a financial advisor or 
qualified in finance.

You should consider seeking independent legal, financial, taxation or other advice to check how information & 
outputs from this sheet relates to your unique circumstances.

The Sheet owner is not liable for any loss caused, whether due to negligence or otherwise arising from the use of, or 
reliance on, the information provided directly or indirectly, by use of this sheet.

The calculators and tools on this sheet are provided for your information and to illustrate scenarios. The results 
should not be taken as a substitute for professional advice. This sheet may contain mistakes and therefore you 
must perform your own due diligence to validate and confirm outputs. All "optimisations", recommendations and 
considerations must be verified by yourself. I take no responsibility for your actions and choices.

Any Tax estimations in this sheet are general estimations at best, are non-specific and have not taken into account 
your financial cirumstances. They are not to be used or taken as Tax advice. Please do your own research and see a 
Tax professional. Again, I am not a tax professional.

All reasonable care has been taken in preparing and designing the calculators and tools; however, the Sheet owner 
provides no warranties and makes no representation that the information provided by the calculators and tools is 
appropriate for your particular circumstances or indicates you should follow a particular course of action.

For a full list of Terms please see this link - https://cspersonalfinance.io/terms

Further use of this sheet indicates acceptance of these terms.

The newest version and future updates! 📈 Some examples of v2+ features

Due to the number of feature/bug requests I've received for this sheet since initial release I've created a paid 
sheet for versions 2+ onwards. I've spent a lot of time on this new sheet and I think it's the fair way to make 

sure I can keep developing this sheet and make it even better, but also reimburse me for the time put in. That 
being said, it's for just 2 coffees (£5) and should make it back at least 10x for you! 

If you would like access to the new v2+ sheet and future updates, please shout me a few coffees using the link 
below and I'll promply add you to the new version!

V2+ Version includes:
- Property & Mortgage Tracking Dashboard

- Crypto, Managed Fund, Stock, ETF Live Price & Performance Tracking
- Full CoinMarketCap Crypto Price Support & Tracking

- Automatic FIRE 🔥 Dashboard & Calculator
- Automatic FIFO Capital Gains Calculations

- International Asset & Currency Support
- Voluntary Super (inc. FHSS) Tracking

- Monthly Net Worth And Savings Email Updates
- Google Calender & Email Investment Reminders

- Mortgage, Credit-Card & Loan Dashboard
- Automatic Investment constribution optimisation system
- Automatic Calender reminders for when to run the sheet

- Monthly/Weekly/2-week pay support
- Generic & Physical Asset Tracking

- Rental & Side Income Tracking
- Expanded ETF/Stocks/Managed Fund Ticker Support

- Further Sheet automations
- Sheet Optimisations making the sheet more responsive/load faster

- Ongoing bug fixes (including lots of fixes to v1.3)
- More features than can fit in here!

Monthly Networth & Saving Email Breakdowns

Automatic FIRE 🔥 Dashboard & Calculator

Shout me some coffee! ☕
This Sheet took a long while to make, so if you 

found this sheet useful please consider shouting me 
some coffees (£5) for coffee via Paypal!

👉 https://cspersonalfinance.io

In return for some Coffees I'll invite you to the 
updated paid sheet with all future feature/bug 

updates and add in any feature requests!

Thank you for your generosity & support :)

Auto Calender/Email Investment & Monthly Recording Reminders

Property & Mortage, Loan Dashboards & Tracking

💎 More info & Purchase Link:
https://cspersonalfinance.io

Please contact me via compiledsanity@gmail.com or /u/CompiledSanity if you have any questions.
Spread the word! 📣

Side Income /  Rental Income Tracking International Managed Fund, Crypto, Cash, Stock & ETF Support

Please share the benefit you've received from this sheet with others! 

Feel free to invite them with this Sheet to try the sheet out:
https://docs.google.

com/spreadsheets/d/1v9ENzdoSIVlfAA2SFVFz6KKVAAu5Knv8klde7bN2Qqo/

Thank you for your help!
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🌎 Official Website:
cspersonalfinance.io

Made by u/CompiledSanity

GETTING STARTED Link to Original Template

Hello and welcome! This tool is designed to make life easy for you, give you a holistic glimpse of your financial position and if you're a stats nerd tell you where you're heading. CHANGELOG
Everything is as automated as possible, data entry takes place once a month and is minimal. Please note to use this Sheet you must have a Google Account. Thanks for visiting :) Date Notes

For a Getting Started Guide, please click here: https://guide.cspersonalfinance.io/

Feel free to share the link to this sheet with anyone you think might use it!

10/1/2020 v1 - Original Release

24/1/2020
v1.1 - A whole bunch of fixes that don't fit in here. Fixes for initial setup process, 
dividend support for shares, fixes for ETF calculations, fixes for Cash calcs, 
Budget tab improvements, performance fixes

29/1/2020 v1.2 - Fix to ETF return Calcs

Setup Step 1 - Click File > Make a Copy and save to your Google Drive. 15/8/2020 v1.3 - Bug fix suggestions from Reddit

v2+ Onwards:
Due to ongoing development, future updates will move to a different sheet (Checkout the 

Welcome Tab!). It includes: 
- Property & Mortgage Tracking Dashboard

- Crypto, Managed Fund, Stock, ETF Live Price & Performance Tracking
- Full CoinMarketCap Crypto Price Support & Tracking

- Automatic FIRE 🔥 Dashboard & Calculator
- Automatic FIFO Capital Gains Calculations

- International Asset & Currency Support
- Voluntary Super (inc. FHSS) Tracking

- Monthly Net Worth And Savings Email Updates
- Google Calender & Email Investment Reminders

- Mortgage, Credit-Card & Loan Dashboard
- Automatic Investment constribution optimisation system
- Automatic Calender reminders for when to run the sheet

- Monthly/Weekly/2-week pay support
- Generic & Physical Asset Tracking

- Rental & Side Income Tracking
- Expanded ETF/Stocks/Managed Fund Ticker Support

- Further Sheet automations
- Sheet Optimisations making the sheet more responsive/load faster

- Ongoing bug fixes (including lots of fixes to v1.3)
- More features than can fit in here!

Check out the instructions in the Welcome tab if you're interested! 
Feel free to message at compiledsanity@gmail.com if you have any questions.

Setup Step 2 - Click Authorize below to authorise and initialise the Sheet. This powers the Sheet calculations.

Description of permissions:

• See, Edit, Create spreadsheets - Required to record your monthly history and organise data in the Sheet. 
This access is restricted to only for the current sheet.

You may receive a popup saying this app isn't verified. This is because the app hasn't 
been published and exists as scripts bundled to this sheet for transperancy.
Click advanced and  'Go to PersonalSavingsScript'. Feel free to audit this code yourself 
via Tools -> Script Editor. 

• More info on Privacy in FAQ [1]

Setup Step 3 - Read the Disclaimer to your bottom right and click I accept below if you agree to these conditions.

Setup Step 4 - Working from left to right, go through all the different tabs and update only cells that are yellow. Everything else is automated.

Only these colours

Setup Step 5 - Hide any tabs that you won't use (Right Click tab -> Hide)

ONGOING 6. ONGOING - HOW TO USE THE SHEET MONTH-TO-MONTH Shout me some coffee! ☕
On the 1st of every month, click click the 'Click to end Month' button in the Net Worth Sheet. This will store and record that month and process all values. Without this the sheet will not write any values 
and you will lose the months progress. This Sheet took a long while to make, so if you found this 

sheet useful please consider shouting me some coffees 
(£5) for coffee via Paypal!

👉 https://cspersonalfinance.io

In return for some Coffees I'll invite you to the updated 
paid sheet with all future feature/bug updates and add in 

any feature requests!

Thank you for your generosity & support :)

< Pictured Left: The Networth update button found in the Net Worth tab.

A few extra notes:
a) Never delete tabs, only hide them!
b) Target allocations in this Sheet for Assets are VERY important. Please make sure that you keep them updated.
c) Look for the dark arrows on cells, mouseover for more info if needed.
d) A lot of tracking relies on trends to be recorded in this sheet. Therefore to start seeing trends at least 2 months of recorded data is needed.

Frequently Asked Questions
Access the Sheets FAQ Section here:

cspersonalfinance.io/faqs

Disclaimer

The information & guidance on this sheet is for general information only.

It should not be taken as constituting professional advice from the Sheet owner. I am NOT a 
financial advisor or qualified in finance.

You should consider seeking independent legal, financial, taxation or other advice to check how 
information & outputs from this sheet relates to your unique circumstances.

The Sheet owner is not liable for any loss caused, whether due to negligence or otherwise arising 
from the use of, or reliance on, the information provided directly or indirectly, by use of this sheet.

The calculators and tools on this sheet are provided for your information and to illustrate scenarios. 
The results should not be taken as a substitute for professional advice. This sheet may contain 

mistakes and therefore you must perform your own due diligence to validate and confirm outputs.

Any Tax estimations in this sheet are general estimations at best, are non-specific and have not 
taken into account your financial cirumstances. They are not to be used or taken as Tax advice. 

Please do your own research and see a Tax professional. Again, I am not a tax professional.

All reasonable care has been taken in preparing and designing the calculators and tools; however, 
the Sheet owner provides no warranties and makes no representation that the information provided 
by the calculators and tools is appropriate for your particular circumstances or indicates you should 

follow a particular course of action.

Further use of this sheet indicates acceptance of these terms.
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Parcel Optimising (Automaticly updated on Monthly update) Initialising Settings

Automatic Investment Amount £0.00 [2]
1/Yearly Frequency (Default: Monthly) 0.0833 Day of Month Paid 14
Bank Interest Rate 2.0% Use Budget Tab? Yes Recommended as Yes. If set to Yes, fill out the Budget category as accurately as possible!
Investment Growth (Automatic) 0.0% Monthly Leftover Savings [3] £1,000.00 If Budget option set to No, fill out how much you would traditionally save in total each month
Purchase Brokerage (Buy only) £5.00 Monthly Salary Deposit [4] £1,000.00 If Budget option set to No, fill out what Salary pay hits your bank Account
Current Cash Deficit £0.00 Allocation Aggressiveness Normal How aggressively do you want to keep aligning with your Asset Allocations?

Market Investment Return 0.00% What is your assumed long-term market return?         

Estimated Tax Rate

Employment Salary £50,000.00 [5]
Predicted Annual Dividends £0.00
Predicted Yearly Earnings £50,000.00

(i) This section has been improved and expanded for usability, 
including a new migration system in v2 ℹ HelpDays into Financial Year 214

2024 Tax Rate (please input) Accept Disclaimer & see mouseover note [6]

https://guide.cspersonalfinance.io/getting-started/sheetoptions-tab


ℹ Help Total Savings Rate/year: £0 [7] No Trend years (~£144,000) until house! Date Savings (ex.S) Pension Liabilities Rolling NW NW Growth Sav. Growth Sav. Rate Proj. NW Notes (From Cash Tab)

Total Assets Nov 2024 £34,500 £18,000 -£20,000 £32,500 - - - - Example: New TV (-£500), Car Service (-£300), Tax Refund (£1500)

Total (£) Gains (£) Gains (%) Dec 2024 £0

ETF's £0 £0 0%
Shares £0 £0 0%
Crypto £0 £0 0%%

Cash Savings £34,500 £0 0%
Pension £18,000 £1,500 9%

Total Assets: £52,500 £1,500 3%
Savings (wo/Pension) £34,500 £0 0%

Total Net Worth: £32,500

Cash, Shares  & ETF Savings: £34,500

Total Liabilities
Name Debt Paid Total

HELP Debt -£20,000 £0 [8] -£20,000

Total: -£20,000 £0 -£20,000

Assets Allocations
Current % Desired % Deficit %

ETF's 0% 0% 0%
Shares 0% 0% 0%
Crypto 0% 0% 0%

Cash Savings 100% 100% 0%

Invest next in: Cash Savings
Total Assets: 100% 100%

Sheet Version 1.3.12 Latest Version: 2.12.2
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Script Status: Success! Last Refreshed: 04/11/2024 12:00am
Last run: 30/10/2024 12:00am Alast: 0

Sheet Errors? No Todays Date 04/11/2024

ℹ Help

https://guide.cspersonalfinance.io/summary-tabs/net-worth
https://compiledsanity.github.io/changelog.html
https://compiledsanity.github.io/changelog.html
https://guide.cspersonalfinance.io/summary-tabs/net-worth


Bank Account Name Amount CASH HISTORY (AUTOMATIC)

HSBC Daily Expenses £500.00 Date Total Cash Cash Gain (£) Cash Gain (%) ETF Movements Savings Rate Monthly Savings Projected Cash. Monthly Spend Spend Notes
HSBC Splurge £500.00 Nov 2024 £34,500 - - £0.00 0% £0 - £0 Example: New TV (-£500), Car Service (-£300), Tax Refund (£1500)

HSBC Mojo £2,000.00 Dec 2024 £0
Lloyds Savings £30,000.00
Broker Cash Balance £1,500.00

ℹ Help Total Cash: £34,500
Next Invest: -

November Cash savings £0

November Total savings £0
 Cash savings/month £0

ETF & Cash savings/month £0
2024 Sum Cash £0

Predicted Cash Savings/Year £0

EOY Predicted Cash Balance £34,500
On Target? No

EOY Cash Goal £38,000
EOY Goal Deficit/month -£292

Time to £50000 Cash Goal Negative Growth!
Cash Savings Target £50,000

November 2024 Cash Amount £34,500
Date of Arrival -

% of Target 69%
Tracker

November 2024  Savings Rate 0%
2024 Savings Rate 0%

3-Month Rate 0%
3-Month Savings Trend Decreasing!

3-Month Saving Rate ±%/Month 0.00%
2024 Recorded Savings £0

House Savings Target/Year £17,000
Years to Target? No Trend

House Price Target £650,000
House Deposit Remaining £144,000

House Deposit Saved £18,500
Monthly House Savings Deficit/month -£1,417

Date of Arrival Never - No Cash Trend
Deposit Tracker - 11% saved

https://guide.cspersonalfinance.io/investments/cash


Ticker Fund Name Live Price 180D History Held Units Live Value Total Return (£) Total Return (%) Allocation Def. Target Alloc. Current Alloc. MGT Fee Location % - US [9] % - Asia % - UK % - EU/Other Div Yield Div Return %/Year
LON:ISF FTSE 100 UCITS £7.98 0 £0.00 £0.00 0.0% -50% 50% 0% 0.18% World 0% 0% 100% 0% - £0.00 -

LON:VUKE FTSE 100 UCITS £35.56 0 £0.00 £0.00 0.0% -35% 35% 0% 0.14% Aus 0% 0% 100% 0% - £0.00 -
LON:VUSA S&P500 UCITS £83.78 0 £0.00 £0.00 0.0% -15% 15% 0% 0.40% Asia 100% 0% 0% 0% - £0.00 -

Insert further rows by inserting rows and copying down formulas. For Managed Fund support please see v2+ in the Welcome Sheet Current Alloc. 0% 0% 0% 0%
ℹ Help Desired Alloc. 15% 0% 85% 0%

CURRENT PORTFOLIO VALUE: £0 ETF Statistics
Total Return (£) £0 Est Ret. %/Year 0% annually Current ETF 0

Total Return (%) 0.0% Next Investment Cash Savings [10] ETF Target Count 3

2024 ETF Dividends after Tax (£) £0.00 Target Date - [11] ETF Limit 10

Total ETF Dividends afer Tax (£) £0.00 1Y Inv. Rate - [12]

  Purchase History Table -  NOTE: All Assets in this table must be in watch table above. ℹ Help

Ticker Order Date △ Units Order Price Order Value Live Price Live Value Capital Gain (£) Capital Gain (%) Sold Units Remain Balance Auto Brokerage

LON:ISF 4-Mar-2019 1 £520.00 £520.00 1 0

LON:VUKE 29-Mar-2019 0 £23.00 -£10.00

LON:VUSA 15-Aug-2019 0 £35.00 -£10.00

LON:ISF 27-Dec-2019 -1 £550.00 -£560.00

Historical Value (Use History Sheet)
Date Total Value Gain (£) Gain (%)

Nov 2024 £0.00 £0.00 0.0%
Dec 2024

https://guide.cspersonalfinance.io/investments/etfs-and-shares
https://guide.cspersonalfinance.io/investments/etfs-and-shares#buying-and-selling


Ticker Current Price Current P/E Total Units Total Worth Allocation Difference Desired Allocation Current Allocation Total Return (£) Total Return (%)
LON:LLOY £0.54 7.74 0 £0.00 -20% 20% 0% £0.00 0.00%
LON:BARC £2.39 8.58 0 £0.00 -50% 50% 0% £0.00 0.00%
LON:GLEN £4.09 - 0 £0.00 -30% 30% 0% £0.00 0.00%

0%
0%
0%
0%

Insert further rows by inserting rows and copying down formulas Amount Allocated: 100%
ℹ Help

CURRENT PORTFOLIO VALUE £0
Total Growth (£) £0
Total Growth (%) 0%

Net Dividends after Tax (£) £0

  Purchase History Table -  NOTE: All Assets in this table must be in watch table above. ℹ Help

Ticker Purchase Date Volume Bought Price Sold Units Order Value Live Price Live Value Capital Gain (£) Capital Gain (%) Remain BalanceAuto Brokerage [13]
LON:LLOY 31/01/2019 5 £28.00 5 £140.00 0
LON:BARC 31/01/2019 0 £95.00 0 £0.00
LON:LLOY 31/01/2019 -5 £35.00 0 -£175.00

Historical Value (Use History Sheet)
Date Total Value Gain (£) Gain (%)

November 2024 £0.00 £0.00 0%
December 2024

https://guide.cspersonalfinance.io/investments/etfs-and-shares
https://guide.cspersonalfinance.io/investments/etfs-and-shares#buying-and-selling


FY Start: 05/04/2024 to 05/04/2025 ℹ Help

Historical Dividends 2024-2025 YEARLY SUMMARY Dividend Reinvestment

Payment Date ASX Tick ETF/Stock Ex-Dividend Units HeldPrice @ Dividend (Estimate) [14] Net Yield
Reinvested?

(Mouse over for note) 
[15]

Net Amount Ticker (Auto) Type Net Dividends [16] ETA to +1U (Months) [17] NET Year Yield Dividend Freq (m) DRP On? DRP Swap?

09/12/2019 LON:ISF ETF 28/12/2019 0 £7.54 0.00% No £0.00 LON:ISF ETF £0.00 - - FILL IN NO NO
16/12/2019 LON:LLOY Stocks 01/12/2019 0 £0.61 0.00% No £0.00 LON:LLOY Stocks £0.00 - - FILL IN NO NO

TOTAL - £0.00

PRIOR FY YEAR SUMMARY (NET)
Auto Date Net ETF Div. Net Share Div. Total Net Div.
2020-2021 £0.00 £0.00 £0.00
2021-2022 £0.00 £0.00 £0.00
2022-2023 £0.00 £0.00 £0.00
2023-2024 £0.00 £0.00 £0.00
2024-2025 £0.00 £0.00 £0.00

TOTAL £0.00 £0.00 £0.00

https://guide.cspersonalfinance.io/investments/dividends




Pension Accounts Balance Historical Pension Values

Balance £18,000.00 Date Growth Setting Total Value Gains (£) Gain (%)
Nov 2024 High Growth 100% £18,000.00 £1,500.00 9.1%
Dec 2024

Market Gains/
Contributions last month £1,500.00

Total Value: £18,000.00

ℹ Help

https://guide.cspersonalfinance.io/summary-tabs/retirement


MONTHLY BUDGET
Monthly Salary [18] £3,500.00 Job Start Date: 1/1/2019 ℹ How to Start Monthly Savings £785.00

Annual after-tax Income: £42,000.00 Auto 6M Emergency Fund: [19] £16,000.00

Annual Savings £9,420.00
If adding new budget item, right click on left number bar and click 'Insert 1 Above' existing budget item.

ITEM % Allocation Monthly £ Weekly £ Yearly £ Bank Account Category
Estimated Savings Rate 22%

General Expenses 1% £50.00 £11.51 £600.00  ING - Daily

 Expenses

- Fuel 3% £100.00 £23.01 £1,200.00  Fill Bank
- Rent/Mortgage 23% £800.00 £184.11 £9,600.00  Fill Bank

- Myki 5% £180.00 £41.42 £2,160.00  Fill Bank
- Groceries 17% £600.00 £138.08 £7,200.00  Fill Bank

-Media Subscriptions 1% £20.00 £4.60 £240.00  Fill Bank
-Haircut 1% £30.00 £6.90 £360.00  Fill Bank

- Mobile Phone 1% £35.00 £8.05 £420.00  Fill Bank
0% £0.00 £0.00  Fill Bank
0% £0.00 £0.00  Fill Bank
0% £0.00 £0.00  Fill Bank
0% £0.00 £0.00  Fill Bank
0% £0.00 £0.00  Fill Bank
0% £0.00 £0.00  Fill Bank

Yearly Expenses - Automatic 5% £170.00 £39.12 £2,040.00  UBank - Savings  Expenses

Splurge/Fun Money 9% £300.00 £69.04 £3,600.00  ING - Splurge Fun

Emergency Fund Topup (Mojo) 1% £50.00 £11.51 £600.00  ING - Mojo Savings

Holiday/Big Purchase Savings 11% £380.00 £87.45 £4,560.00  UBank - Savings Holiday

Cash Savings - Automatic 22% £780.00 £179.51 £9,360.00  UBank - Savings 
Savings

Investment Savings - Automatic 0% £0.00 £0.00 £0.00  UBank - Savings 

Automatic Salary Bank Transfers [20] Yearly Expenses  Year Cost Monthly

Automate your incoming pay and send it back out to automate your savings. This works best with a 
splurge/expenses account.

Car Rego £840.00 £70.00
Car Insurance £770.00 £64.17

Bank Name Amount Car Service £320.00 £26.67
 ING - Daily £50.00 Birthday/Christmas Gifts
 Fill Bank £1,765.00

 UBank - Savings £1,330.00
 ING - Splurge £300.00
 ING - Mojo £50.00

https://guide.cspersonalfinance.io/summary-tabs/budget


INSTRUCTIONS ON 
MOUSE OVER [21] Shares ETF's Crypto Cash Retirement Liabilities Salary ℹ Help

Pay Month Ending Shares Value Gain (£) Gain (%) ETF Value ETF Changes Gain (£) Gain (%) Crypto Value Gain (£) Gain (%) Cash Value Gain (£) Increase (%) Pension Value Gain (£) Gain (%) Debt Balance Paid -
November 2024 [22] £0.00 £0.00 0.00% £0.00 £0.00 £0.00 0.00% £0.00 £0.00 0% £34,500.00 £0.00 [23] 0% £18,000.00 £1,500.00 9.1% -£20,000.00 £0.00 £3,500.00

December 2024

https://guide.cspersonalfinance.io/summary-tabs/history


[1] The Sheet has been designed to be completely self-contained. When you download the Sheet and 
make a copy, it's now it's own independent copy hosted by you. The external services permission is 
triggered because the Sheet uses live Crypto, Stock and Managed Fund prices which requires the sheet to 
fetch external prices from Google Finance, Yahoo Finance & Bloomberg.

You can review all the formulas to see how that works, but it's strictly a one way fetch process and if you go 
Tools -> Script Editor in the Document you can review all the code yourself to make sure it checks out. 
Furthermore, no personally identifying information or sensitive information such as passwords/usernames 
are needed nor requested. The only inputs into this Sheet are holdings and amounts, the minimum 
information needed to determine your Networth & associated performance.

[2] =average(Budget!C17,Budget!K18*(averageif(Cash!F4:F,">="&INDEX(Cash!F:F, MATCH(99^99,Cash!
G:G, 1)-1),Cash!L:L)-2*sum(Budget!C14,Budget!C19)))

[3] This is how much you have leftover to save after all your expenses. This will then be split up to tell you 
how to save.

[4] This is your reliable monthly salary (not side income!) that hits your bank account.

[5] Before Tax/Super

[6] See Disclaimer. This is a non-specific generalised estimate at best. Do your own research and see a 
Tax professional. This does not take into account any cirumstances for your situation and I am not a Tax 
professional.

If you have a more specific tax rate for yourself, apply it here.

[7] This requires at least 2 months savings to be recorded for a trend to form.

[8] Update at Tax Time

[9] This info can be found on Vanguards/Investor websites

[10] Please read the disclaimer before acting on this information.

[11] Please read the disclaimer before acting on this information.

[12] Please read the disclaimer before acting on this information.

[13] Brokerage Logic: This is setup so for your first purchase of a holding there is 2x Brokerage fees 
(buy/later sell) and then 1x brokerage for all purchases of that holding thereafter (only buy, you'll likely sell 
in 1 big batch under one parcel). 

If this does not fit your situation, feel free to edit this column to match (ie. DRP).

[14] Please use Sharesight/holding statement to confirm

[15] Ticking yes here only helps with Dividend Income calculations. It does not automatically enter in DRP 
purchases and account for it in your total held units.

If DRP has purchased new units for you, please enter these yourself into the ETF/Stock sections as new 
additional purchases.

Check Sharesight or Dividend Statement from your broker to confirm DRP pricing & amounts.



[16] What hits your bank account and is 'returned' to you to be useful. I know this is highly dependant on 
Tax but that's too messy to be accounted for.

[17] This calculates how many months will it take for your dividends to buy 1 unit all by itself with DRP 
turned on.

[18] What you gets deposited in your bank reguarly. Use an average value if needed. 

Don't put Side income here! Keep that in the Side Income Sheet

[19] 6-month emergency fund is prioritized over any ETF purchases. 

Set to whatever figure you would like if you want to override this (ie. $0).

[20] This can help you save. Don't leave all your savings in a bank attached to your Card, you'll probably 
spend it!

Automatically send it each month to your seperate savings account.

[21] DO NOT DELETE COLUMNS EVEN IF YOU DON'T OWN THAT ASSET. It will break all scripts!

[22] If you need to add more rows, don't copy paste from this row as it has modified formulas to initialise 
this sheet.

[23] If you can manually calculate this, enter in how much money you saved in this last month to kick start 
all the statistics.


